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Chapter 1. IBM Campaign v9.1.0 system requirements and
compatibility

IBM® Campaign is part of the IBM EMM suite of products. Campaign version 9.1.0
requires Marketing Platform 9.1.0.

For best results, set your screen resolution to 1440 x 900 or higher. Lower
resolutions can result in some information not being properly displayed. If you use
a lower resolution, maximize the browser window to see more content.

Where to find complete system requirement and compatibility
information

For a list of IBM EMM product versions compatible with this product and a list of
third-party requirements for this product, see the Recommended Software
Environments and Minimum System Requirements document. This document is posted
under Detailed System Requirements on the IBM Support Portal website:
(http://support.ibm.com).

Note: To access the IBM EMM documentation from the Support Portal, you must
log in with an IBM account. This account must be linked to your IBM customer
number. To learn more about associating your account with your IBM customer
number, see Support Resources > Entitled Software Support on the Support
Portal.

You can also access this document by selecting Help > Product documentation
when you are logged in to IBM EMM.

Installation and upgrade

You can upgrade to Campaign 9.1.0 (including eMessage) from versions 8.5.x, 8.6.x,
or 9.0. If you have a prior version of Campaign or eMessage, follow the upgrade
paths that are described in the IBM Campaign Upgrade Guide.

The default top-level directory for IBM EMM installations is /IBM/EMM (for UNIX)
or C:\IBM\EMM (for Windows). The product installers place product files in
individual subdirectories under the EMM directory. For more information, see the
IBM Campaign Installation Guide or the IBM Campaign Upgrade Guide.

The response file of each product installer includes the version number.

Browser behavior in IBM EMM products
IBM EMM products have certain browser restrictions and requirements.

Supported browsers

For a list of supported browsers, see the IBM Enterprise Marketing Management
Recommended Software Environments and Minimum System Requirements for version
9.1.0.
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Pop-up blockers

You must disable any pop-up blockers in your browser or browser add-ons, such
as toolbars. Pop-up blockers prevent the flowchart window from opening.

Navigation methods

Do not use the browser controls to navigate. For example, avoid using the
browser's Back and Forward buttons. Instead, use the controls supplied in the IBM
EMM user interface.

Using multiple browser windows in Internet Explorer

This restriction applies to using Internet Explorer (IE) with IBM Campaign or any
module that uses Campaign flowcharts (eMessage, Contact Optimization, Interact,
Distributed Marketing).

To log in multiple times to view side-by-side information, you must open IE and
log in to IBM EMM. Then select File > New Session in the IE menu bar. In the
new IE browser window, log in to IBM EMM as the same or a different user.

Important: Do not use any other method to open multiple sessions. For example,
do not open a new tab; do not open another browser session from the Start menu
or desktop icon; and do not use File > New Window in IE. These methods can
corrupt information that is shown in the application.

For details, see the IBM Campaign User's Guide.
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Chapter 2. New features and changes in IBM Campaign v9.x

IBM Campaign version 9.x includes the following new features and changes.
v “New features and changes in IBM Campaign v9.1.0”
v “New features and changes in IBM Campaign v9.0.0” on page 6

New features and changes in IBM Campaign v9.1.0
IBM Campaign version 9.1.0 includes the following new features and changes.

IBM EMM installation and upgrade improvements

The improvements to the installation and upgrade process include:
v Installation guides for all products have been rewritten and reorganized into

separate installation and upgrade guides, to make information easier to find and
use.

v The installers have been enhanced to include better descriptions of the
information you need to enter and to clarify what steps to take during each
stage of the installation.

v Each installer now provides links directly to the product installation and
upgrade guides, in either PDF or HTML formats.

IBM eMessage offer integration

Customers who license both IBM Campaign and IBM eMessage can now benefit
from full offer lifecycle capability from IBM Campaign to IBM eMessage.

The new functionality allows customers to create offers in IBM Campaign, relate
them to an asset in IBM eMessage, send the mailings, and automatically track the
contacts (bounces are subtracted). The results are written to the Contact History
tables. In addition, responders (those who click links in emails), are automatically
tracked and recorded in the Response History tables.

Using IBM Campaign reporting, users can now track the full cycle for offers and
see ROI data in a campaign performance report for IBM eMessage related
emailings.

To configure the integration, see the IBM Campaign Administrator's Guide.

IBM SPSS® Modeler Advantage Enterprise Marketing
Management Edition integration

IBM Campaign introduces support for a new predictive analytics offering in the
Campaign family, called IBM SPSS Modeler Advantage Marketing Edition, planned
for availability in December 2013.

IBM SPSS Modeler Advantage Marketing Edition is for users who want to
incorporate statistical modeling capabilities into their IBM Campaign management
solution.
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IBM SPSS Modeler Advantage Marketing Edition is based on IBM Analytical
Decision Manager, part of the SPSS sophisticated predictive analytics suite,
including components of SPSS Modeler and IBM SPSS Collaboration and
Deployment Services.

IBM SPSS Modeler Advantage Marketing Edition provides best-in-class
automation, intelligent modeling, and integration with campaign management. It
provides predictive analytics for building response, customer valuation, cross-sell
or market-basket association models, as well as clustering models. It requires and
is fully integrated with the IBM Campaign management solution.

With IBM Campaign, you can build and maintain your models over time, as well
as use these models to score data in your customer database and apply those
scores for more effective marketing. By targeting customers or prospects that are
more likely to respond to a particular offer, or predicting the lifetime or potential
of a client, you can increase the ROI of your marketing campaigns.

For more information, see the IBM Campaign and IBM SPSS Modeler Advantage
Marketing Edition Integration Guide.

New configuration property: overrideLogToHistory

A new configuration property, overrideLogToHistory, was added to Campaign |
partitions | partition[n] | server | flowchartConfig.

This property provides the ability to ensure that contact history is always recorded
during production runs.

Administrators can use this property with logToHistoryDefault to specify whether
users are allowed to override the Log to Contact History setting when configuring
a Mail List, Call List, or Track process.

If an administrator enables logToHistoryDefault (which causes Log to Contact
History to be set in a Mail List, Call List, or Track process) and disables
overrideLogToHistory, then all new flowcharts that are created from that point
will have Log to Contact History set. As a result, all flowchart production runs
will always write to contact history.

This prevents data loss during important production runs. For example, it avoids
the situation where a user clears the Log to Contact History setting and then
forgets to re-enable it.

Note: For upgrades, the value of Log to Contact History for a particular flowchart
is retained as it was before the upgrade, and the ability of users to change the
value depends on the permissions that are assigned to the user.

Configuration properties are described in the IBM Campaign Administrator's Guide.

New configuration property: disallowAdditionalValForOfferParam

A new configuration property, disallowAdditionalValForOfferParam, was added
to Campaign | partitions | partition[n] | server | flowchartConfig.
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Use this property to disallow users from selecting values other than the ones
provided for a drop-down list when users configure a contact process. This
property affects the behavior of all drop-down lists in contact processes (Mail List,
Call List).

For example, if a Mail List process includes a credit card offer, and the offer is
defined to provide a list of terms:
v If disallowAdditionalValForOfferParam is true, users are restricted to selecting

values from the drop-down list.
v If disallowAdditionalValForOfferParam is false, users can select values outside

of the list, for example from a database table.

Configuration properties are described in the IBM Campaign Administrator's Guide.

New configuration property: numRowsReadToParseDelimitedFile

A new configuration property, numRowsReadToParseDelimitedFile, was added to
Campaign | partitions | partition[n] | server | internal.

This property is used for table mapping of delimited files and it is also used by the
SPSS Score process box when importing a score output file from IBM SPSS
Modeler Advantage Marketing Edition. To import or map a delimited file,
Campaign must parse the file to identify the columns, data types, and field
(column) widths. By default, Campaign examines 100 lines (the first and last 50) of
a delimited file. In most cases, this is sufficient to determine field widths, and
Campaign allocates a width based on the largest value it finds within those lines.
However, in very large delimited files, a later field might exceed the estimated
length, which can cause an error. Therefore, if you are importing or mapping a
very large file, you can increase this value to parse a larger number of lines. For
more information, see the Campaign Administrator's Guide.Configuration properties
are described in the IBM Campaign Administrator's Guide.

Alert users of offer deletion

When users attempt to delete offers or folders that contain offers, automatic
verification is done if any of the offers are still active. In the following cases, an
offer or offer list is considered to be active:
v Contact history is populated for the offer or offer list.
v The offer is assigned to a campaign using the Add/remove Offers link (CH

may/may not be populated).
v An offer LIST is assigned to a target cell spreadsheet (CH may/may not be

populated).
v An offer LIST is assigned in a Mail List process but the Mail List process did not

run.
v An offer LIST is assigned in a Mail List process and the Mail List process ran

with "Log to CH" off (CH is NOT populated).

In the following cases, an offer or offer list is NOT treated as active:
v The offer is used in an offer list (CH is NOT populated).
v The offer is assigned to a target cell spreadsheet (CH is NOT populated).
v The offer is assigned in a Mail List process but the Mail List process did not run

(CH is NOT populated).
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v The offer is assigned in a Mail List process and the process ran with "Log to
CH" off (CH is NOT populated).

v An offer LIST is assigned to a campaign using the Add/remove Offers link.

Important: If you attempt to delete an active offer or offer list, a confirmation
message indicates that the offer or offer list will be retired instead of deleted. To
prevent further use of offers or lists that are referenced in system tables, you
should retire rather than delete them.

Support data filtering on the Audience process

In addition to supporting data filtering on top level Select and Extract processes in
a campaign flowchart, the same functionality has been added to top level Audience
processes. This was not available in previous releases of IBM Campaign.

Note: Data filters do not apply to raw SQL queries or to custom macros that use
raw SQL nor when profiling for values.

New browser support

Version 9.1 adds support for Safari (Macintosh) and Internet Explorer 10
(Windows). For details, see the Recommended Software Environments and Minimum
System Requirements for IBM Enterprise Marketing Management version 9.1.0.

Clear button added to Contact History Logging Options dialog

A Clear button has been added to the Contact History Logging Options dialog,
which is available when configuring a Call List or Mail List process. The Clear
button lets you set the Contact Date (Flowchart run date will be used if empty)
field back to its default value (empty). Use the Clear button if you selected a
contact date but then decide to use the flowchart run date instead.

OK and Apply button behavior

If a dialog box is opened in Campaign and you do not make any changes, the OK
and Apply buttons are not active. The buttons are active only if changes are made.
Previously, the buttons were active even if no changes were made. If you want to
close the dialog without making changes, use the Cancel button or close the dialog
by clicking X.

Connection lines in flowcharts

Connection lines that cross over another process box in a flowchart are shown on
top of that process box in order to clearly indicate how processes are connected.
This is a change from the way connection lines were displayed in pre 9.x versions.
Flowchart designers can reposition processes in the flowchart to avoid crossed
connection lines.

New features and changes in IBM Campaign v9.0.0
IBM Campaign version 9.0.0 includes the following new features and changes.

Branding

The Unica® name is no longer used. For example, IBM Unica Campaign was
renamed IBM Campaign.
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IBM Coremetrics was renamed Digital Analytics.

Utilities

The ActiveX cleanup utility (uacflchk) is no longer supplied, as it is no longer
needed.

There is a new IBM Marketing Platform utility, alertConfigTool, which registers
alerts and configurations for IBM EMM products. For details, see the IBM
Campaign Installation Guide.

Configuration

There is a new configuration property (Settings | Configuration | Campaign |
Partitions | partition[n] | dataSources | DefaultTextType) for ODBC data
sources. This property tells IBM Campaign how to create text fields in the
destination data source if the source text fields are from a different data source
type. For more information, see the IBM Campaign Administrator's Guide. (TT
DOC00628)

A new configuration property was added (Affinium | Campaign | partitions |
partition[n] | server | flowchartConfig | legacyMultifieldAudience). In most
cases, you can leave this property set to the default value of FALSE. Campaign
v8.5.0.4 and newer name multifield Audience ID fields according to the audience
definition, regardless of the source of the fields. When you configure processes to
use multifield Audience ID fields, you now see the new Audience ID naming
convention for multifield audiences. Already-configured processes in flowcharts
created in previous Campaign versions should continue to work. However, if old
flowcharts fail because of the change in the naming convention, you can revert
Campaign behavior by setting legacyMultifieldAudience=TRUE. (RTC 5219
DEF063741)

The Campaign | Server | fullContextPath property is now used to specify the
URL that Campaign flowcharts use to communicate to the application server
Listener proxy. This property is undefined by default, which causes the system to
determine the URL dynamically. When the Marketing Platform is integrated with
the IBM Tivoli® web access control platform, you must set this property to the
Campaign URL in Tivoli.

Flowcharts

Beginning with version 9.0, the flowchart workspace was redesigned to change the
look and feel and improve usability. The framework is now based on a Dojo
component, Dojo Diagrammer, instead of Active-X. ActiveX, supported only in
Internet Explorer, requires downloading a plug-in control on the client to work
with flowcharts. Because many customers are not comfortable downloading
plug-ins, and because ActiveX will not be supported in future versions of Internet
Explorer, the Dojo component has been introduced to provide the flowchart
workspace going forward.

The redesign includes changes to the appearance of flowchart and report
components, including toolbars, dialog boxes, progress indicators, and related
controls. The overall functionality is the same.

The flowchart window looks similar to the following example:
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The following list summarizes the changes:
v Separate flowchart window. When you create or edit a flowchart, a separate

flowchart window opens. Be aware of the following features of the new
flowchart window:
– When you click the flowchart tab in the main Campaign window, the main

window contains a link that says "The flowchart is open in another window.
Click here to display it." If you click the link while the flowchart window is
already open, the flowchart window is activated. If you have closed the
flowchart window, clicking this link reopens the flowchart in View mode.

– Pop-up blockers prevent the flowchart window from opening. You must turn
off any pop-up blockers in your browser or browser add-ons, or set up a
specific exception for the Campaign server.

– You can move and resize the flowchart window up to the size of your screen.
You can also work in the main Campaign window while the flowchart
window is open.

– You can have only one flowchart window open at a time. If you open or edit
a different flowchart while a flowchart is already open, the new flowchart
will replace the current flowchart in the open window. If you have unsaved
changes in the current flowchart, you will be prompted to save them before
the new flowchart opens.

v New toolbar icons. The toolbar contains updated icons, and also contains a
number of new options to provide added control over the flowchart and its
appearance.

v Process box updates. The process boxes on the palette have updated icons to
make them easier to identify and select.
Connect process boxes by drawing a line from any of the four connection points
that are visible on the process box (left, right, top, or bottom), instead of being
restricted to the center of the process box as in the ActiveX control.
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Note: Contrary to prior releases, not all process boxes and dialogs that use the
new look and feel are resizable. This is addressed in Campaign fix pack 9.1.0.2.

v Drag and drop. True drag and drop is supported, so you can drag any process
box from the palette to the workspace, instead of clicking in the workspace.

v New flowchart viewing and editing tools. The flowchart window no longer
uses the grid-based layout of the ActiveX control. Instead, you can move process
boxes freely, and place them anywhere on the flowchart. For that reason, new
tools are available to adjust flowchart appearance when a flowchart is open for
editing or viewing:
– Use the alignment options on the toolbar to align two or more selected

process boxes: Align left, Align right, Align top, Align bottom, Align center
vertical, Align center horizontal. The grid of gray dots is no longer used
because alignment options are provided.

– Use the Change Layout options on the toolbar to apply a predefined layout to
your flowchart: Tree, Org Chart, Circular, Hierarchical.

– Use Zoom In, Zoom Out, and Reset Zoom on the toolbar to improve the
visibility of portions of the flowchart. You can also use press the Control key
on your keyboard while using the scroll wheel on your mouse to zoom in
and out.

– Use Fit Contents on the toolbar to resize the flowchart to fit in the workspace.
Then, if needed, use the Zoom options or the panning box to further refine
the view.

– Use Search on the toolbar to find a process box by name in the flowchart. The
search tool is not case sensitive. When a search result is found, the matching
process box is centered in the flowchart window and highlighted. Click the
Search icon again to continue to the next match.

– Use Select All on the toolbar to select all process boxes in the flowchart.
– Use the panning box in the lower right corner of the flowchart window to

highlight the area that you want to see. Panning is especially useful in
flowcharts with many process boxes.

v Running flowcharts. The new flowchart window provides new icons for the run
states for a process box, most notably the icons indicating that the flowchart is
running, indicated by an animated icon, or paused, providing a status icon that
was not available with the ActiveX control.

v Dialog box enhancements. The dialog boxes in the flowchart, especially for
configuring process boxes, have been improved in this release. Some of the
changes include the following modifications:
– The behavior of lists in some dialogs has changed. For example, you can use

Ctrl+click to select multiple items. Lists that can be expanded are now
indicated by a small arrow next to the list, instead of a plus sign (+).

– The appearance of process dialog boxes has been updated to improve their
usability, while keeping the layout and functionality similar to past releases.

– You no longer need to use a separate edit field to modify cell values in a grid
in process box dialogs. Double-click any cell to edit it.

v New export options. There are changes to how you export profile data after you
profile a field in a process. Previously, data was exported to XLS and the file
name was hardcoded to "Campaign.xls". Now data is exported to CSV
(comma-separated values) format. Use the File name field to assign a file name.
The default name is the dialog box title, "Export Report Data".

For information about the new and changed features, see the following topics in
the IBM Campaign User's Guide:
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v Flowchart workspace overview
v Working with process boxes
v Changing flowchart appearance

To get help when a flowchart is open for editing, click the help icon 
 

in the
flowchart window toolbar.

Reports

Some changes were made to report appearance. For example, the legend at the top
of cell reports was improved to be more legible.

The Cell Waterfall report now lets you specify which path in the flowchart to
analyze, if the selected cell is connected to multiple downstream processes. Use the
Path list in the report toolbar to select a path to analyze.

Information about installing, upgrading, and configuring reports is no longer in
the IBM Campaign documentation. This information is now consolidated in a new
guide, IBM EMM Reports Installation and Configuration Guide.

Table mapping

With the replacement of the ActiveX control with a Dojo-based user interface, the
Table Mappings dialog has been updated and enhanced. The essential functionality
is the same, but the Save and Load mappings controls have been replaced by
drop-down lists, as shown in the following example:

Additional changes

The Russian language is now supported. For information about setting locale
preferences, see the IBM Marketing Platform Administrator's Guide.
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Chapter 3. Fixed defects in IBM Campaign

The following table lists defects that were fixed in Campaign 9.1.0, sorted by defect
number.

Table 1. Campaign fixed defects

Issue ID Description

Connections between process
boxes may overlap when user
switches from horizontal to
vertical mode

2980 When users switch between horizontal and vertical view modes,
the connection lines and processes may overlap.

Caching in DOJO displays the
wrong information until the
process box information is
completely loaded

6141 Until a process box loads completely, previous information, or
information pertaining to the previous process box displays in the
background. When the loading of all data is done, the screen is
refreshed and shows the most up to date data.

Grid borders are not displayed
wherever data is not present.

6692 In certain process boxes, if no data is present in a grid column,
the borders around the cell in the grid are not displayed.

If contact date is year 2050 then
the Optimize process box shows
error 10404: unable to
communicate with server
process; server process might
have exited.

6910 Contact date cannot be later than 2037.

User cannot see complete 3D
Graph in the report window

8036 Due to maximization limits on the report window, the entire 3D
report cannot be shown in one window without scrolling.

Process boxes overlap on
flowchart window

8603 In certain scenarios, processes might overlap one another.

A deleted flowchart tab might
continue to display

8955 A deleted flowchart tab displays until the campaign or session is
revisited again in a specific condition.

The Offer and Control-Cell
columns for Control Cells do not
display as disabled on the
Treatment Tab of the Mail List.

9163 On the treatment tab of the Maillist or Calllist process, columns
related to the Control cells and related offers are not greyed-out.
You cannot add offers for control cells, so the columns should be
disabled.

Upgrade does not put correct
information in setenv.bat for
Marketing Platform

9359 When running the Campaign upgrade scripts, there is a pointer
in "setenv.bat" to the platform home directory.
UNICA_PLATFORM_HOME must be set to run acUpgradeTool. If it is
not set, the user is prompted to provide the path while running
the tool.

If the Marketing Platform is installed on a different machine from
Campaign, the path of platform home is not accessible to the
upgrade tool. To continue, the user must enter another accessible
path for platform home. This can be in any directory.

JS error displayed when click OK
on Treatment tab in Maillist PB

11416 An error no longer occurs in this situation.

Users can specify the table field
by manually entering a string in
the value drop-down of the
Parameters tab even when
disallowAdditionalValFor
OfferParam is set.

33832 When the configuration property
disallowAdditionalValForOfferParam is True, users should not
be able to select any Table Value/UCGF/Derived Field in the
Value drop-down of any parameter on the Mail List process
Parameters tab for any offer attribute.

© Copyright IBM Corp. 1998, 2015 11



Table 1. Campaign fixed defects (continued)

Issue ID Description

Schedule fails if flowchart
renamed/moved and it has one
schedule completed

062623 TT The flowchart schedule fails with Error 701 if the flowchart is
renamed or moved and it has one schedule completed.

Error "10490 Json data received
from web app has datatype
mismatch" on OK button of
Sample PB.

72644 If you click OK or select another tab after specifying the number
of samples or segments in the Sample process box, the following
error message appears: "10490 Json data received from web app
has datatype mismatch". The workaround is to click OK again or
select the tab a second time.
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Chapter 4. Known issues in IBM Campaign

The following table lists known issues in Campaign 9.1.0, sorted by defect number.

Table 2. Campaign known issues

Issue ID Description

Mail List process box gets
unconfigured with error
"31606:History table are
changed" on Flowchart run.

NA 1. There is no issue if the history tables are mapped prior to
building a flowchart and adding a Mail List process. 2) If you
do not follow step 1, you can still map the history tables after
the error appears. If you edit the flowchart and configure the
process box, the process will run.

Message when running
installer in UNIX console
mode

NA When running the installer in UNIX console mode, an
informational message indicates that the installer .bin file
was not found. You can ignore this message.

Unable to open flowcharts
after migrating non-ASCII
data

NA After migrating non-ASCII data to Campaign 8.6, in some
cases you cannot open Campaign flowcharts on the target
system. Session flowcharts open successfully. To work around
this issue, remigrate the campaigns in overwrite mode. You
can then open the flowcharts.

Hot keys are not
implemented on most of the
windows

2968 In the Dojo implementation it is not possible to use keyboard
shortcuts to activate certain functions. Instead the user must
click buttons.

Nodes swap places in a
Select process box.

7275 When you select a derived field in a Select process, then close
the Derived Fields dialog, the User Variables and Derived
Fields items change position in the list of Available Fields.

Incorrect report displayed
for cells which have not yet
run.

7844 For cells which have not yet run, the report for the previous
cell displays.

The server might crash
when running the Collect
Flowchart data functionality.

8019 If a text value is entered in the date field on the Collect
Flowchart data functionality, the server process might crash.

Summary file option in
Maillist should be disabled
when Export to File is
unchecked.

13460 When the Export to File option is unchecked on the
Fulfillment tab of the Mail List process box, the Summary
File option is enabled but should not be.

There should be a way to
map DCH from UI when
field name for CH table is
changed.

13502 There should be a way to map the UA_DtlContactHistory
table after changing a column name in the
UA_ContactHistory table. To map UA_DtlContactHistory,
change the source table's column name accordingly (so the
Source Table fields and Required Fields match) and then map
the table.

Warning message about
offer being used in List
appears twice while deleting
active offers.

36267 The message "WARNING: The "Offer Offer1" offer(s) has
been used in one or more offer lists. Deleting this offer will
automatically remove it from these offer lists. Do you want to
continue?" appears twice.

Problem displaying currency
with 3 decimals in Offer UI.

57901 Template with parameterized attribute shows three decimal
places. After saving an offer, only two decimal places appear.

Information related to
associated products does not
appear in offer on
Marketing Operations.

TT DEF062333 When an offer created in Campaign with products associated
with it is imported in Marketing Operations, information
about the associated products is not available in Marketing
Operations.
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Table 2. Campaign known issues (continued)

Issue ID Description

If it was not mapped
initially, theDigital Analytics
translation table is not
available in the Segment
process box.

TT DEF063392 No translation table or any other user table is available in the
Segment process box, if the translation table was not mapped
initially.

Date handling with Oracle
for offer templates with
very old dates.

65446 Offer templates that contain very old dates (such as 214)
cannot be saved. An exception occurs stating that the
supplied value is not a valid instance of data type datetime.

The defined decimal places
in a custom attribute are
ignored in Maillist.

66057 Using an Offer Custom Attribute in a Mail List, the number
of decimal place specified in the Custom Attribute definition
are ignored.

Select PB fails with Error
11528 when configured
using a Custom macro
created based on Dimension
Table.

71062 A custom macro that is based on a dimension table can result
in process errors, such as Error 11528 for a Select process,
because the custom macro base table name is prepended to
the selected field name, along with the dimension table name.

Difficult to assign a control
cell to a target cell on
Treatment tab of Mail List
process if offer is assigned
first to the target cell.

71065 When you click the control cell grid cell to assign a target
cell, the target cell select becomes a small thin line which
makes it difficult to select. This only happens if you assign a
control cell to a target cell that is at the top of the dialog.
Click again in the dialog and the drop-down list will appear.

Clicking "Return to previous
page" distorts the UI in
some cases.

75262 Use the links within the products to navigate in IBM EMM
products, rather than the browser controls.

Unnecessary \jre is added
for
PLATFORM_CLASSPATH
in setenv.sh for upgrade
from 8.5+To9.1.

80929 This does not impact the upgrade because the
PLATFORM_CLASSPATH variable is no longer used by the
upgrade.

SPSS Model PB is failing
with error 18009.

81309 This issue occurs only with models that have fewer than 20
records.

Campaign Upgrade Logs
shows error related to
Optimize in the log files.

90944 When upgrading, if you see the following warnings, you can
ignore them, as they are harmless: WARN
upgradeTool.AC80UpgradeTask [1014] - Unable to find
param: Affinium | Campaign | partitions | partition1 |
Optimize | DisplayFormat WARN
upgradeTool.AC80UpgradeTask [1028] - Unable to find
param: Affinium | Campaign | partitions | partition1 |
Optimize | AlgorithmTuning | ConflictPredictionPercentage

Even if no changes are done
to the Extract PB a message
"Process run results will be
lost, Continue ?" is
displayed.

90956 If you open an Extract process configuration dialog and click
OK without making any changes, this message appears. The
message should not appear when no changes have been
made.

Campaign and Interact
upgrade script.

90970 Unwanted class name is displayed on upgrade script
execution: "com.ibm.net.SocketKeepAliveParameters". There is
no impact on functionality. You can ignore these messages.

ETL log does not use actual
table names.

93872 Unmapped tables cause the ETL to fail and exceptions to be
written to the ETL log file. The audienceid is appended to the
table name in the log.
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Table 2. Campaign known issues (continued)

Issue ID Description

Error when changing the
model Type from Predictive
to Association.

93877 This also occurs if you click the Data tab. Data is scanned
automatically and hence on executing the SPSS Model
process the results are incorrect.

Non ASCII characters are
truncated from offer name.

93906 This is a display issue only. When you click Link to IBM
eMessage Digital assets on the offer page to see the
associated asset, non-ASCII characters are truncated from the
offer name.

Campaign upgrade script
execution completed with
errors related to drop
statements.

102958 During upgrades, there is a message "Unable to execute all
SQL updates successfully, please check the log file for
details." This is related to the following drop statements and
does not impact the upgrade script execution: DROP TABLE
UA_OfferSuppression DROP TABLE UA_RespTypeMapping.

JS error when adding
flowchart.

106625 This happens only when Interact is installed AND the option
'Display a notification about every script error' is enabled in
the Browsing section of the Advanced tab for Internet
Options in Internet Explorer 9 and 10. By default this option
is not enabled.

Mapped table/file node not
displayed in Create Derived
field window launched from
Extract tab of Extract PB.

106626 Workaround: Create the derived field from the Source tab of
the Extract process and it will be available on the Extract tab.
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Chapter 5. Known limitations in IBM Campaign 9.1.0

The following table lists known limitations in Campaign 9.1.0.

Table 3. Campaign known limitations

Issue ID Description

Dialog behavior NA In certain cases, it is necessary to click twice in order to
activate a field or change a field value.

Unused configuration
property:
monitorEnabledForEmessage

NA The following configuration property is not currently used:
Campaign | monitoring | monitorEnabledForEmessage.

Relevant products limitation NA When offer management is performed from IBM Marketing
Operations, the "relevant products" functionality, which relates
product IDs to offers, is not available.

Blank or incorrect results from
derived fields in a Mail List
process. This can occur in a
process box that uses a
derived field that calls a
Generated field (UCGF) that
changes value.

NA Do not use a UCGF in a Mail List derived field if the UCGF is
not constant. Also, from the Parameters tab, do not create a
derived field to call a UCGF to populate offer attributes.

For details, see the following Tech Note:http://
g01zciwas018.ahe.pok.ibm.com/support/dcf/
preview.wss?host=g01zcidbs003.ahe.pok.ibm.com
&db=support/swg/istech.nsf
&unid=C4A93DC0ED188D6985257A6B00699C45
&taxOC=SSCKNRB&MD=2012/08/31%2015:08:35&sid=

Windows impersonation is not
working.

NA Windows impersonation was implemented for use with Active
X, which was replaced by the Dojo/Web client in v9.0 and
later. Therefore, Windows impersonation support should no
longer be needed.

Profiling a Campaign
Generated Field (UCGF) does
not yield correct results.

NA Some UCGFs have a value according to the cell or the offer
being processed. For cell-related UCGFs, only the value
associated with the first cell appears during profiling.

The default value for a custom
cell attribute does not appear
when you open the Target
Cell Spreadsheet.

NA Although the default value is not initially displayed, it will be
used. The value can be displayed or changed by clicking or
opening and editing the custom cell attribute in the TCS.

UA_UsrResponseType Name
field cannot contain restricted
string.

NA The UA_UsrResponseType.Name field cannot contain a left
parenthesis followed by a single quote.
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Table 3. Campaign known limitations (continued)

Issue ID Description

Use unique TempTablePrefix
for each data source when
mapping multiple data
sources to same physical
database.

NA If you mapped multiple data sources in Campaign to the
same physical database, and you use the same
TempTablePrefix for more than one of the data sources, when
you use the cleanup utility to delete orphaned temp tables, it
may falsely identify temp tables as orphaned, when they are
in fact legitimate temp tables defined from a different
Campaign data source.

Any deleted temp tables will automatically be recreated when
you rerun affected flowcharts, but as a best practice, use a
unique TempTablePrefix for each data source when mapping
multiple data sources to the same physical database.

If the data sources defined in Campaign map to different
schemas in the database, another solution is to ensure that the
database user who runs the cleanup utility does not have
privileges to drop tables in other schemas in the same
database.

WebLogic 11g and AIX® 6.1 or
higher

NA If you use the combination of WebLogic 11g and AIX 6.1 or
higher, a manual workaround is required to address
classloading issues in WebLogic. The workaround involves
removing the xercesImpl.jar file from the Campaign.war file,
and repackaging it before deploying. Full details are included
in the installation steps in the Campaign Installation Guide.

Unused configuration
property: ShareConnection

758 The following configuration property is no longer used:
Campaign | Partitions | partition[n] | dataSources |
ShareConnection.

Folders without any Custom
Macros are displayed under
the "Custom Macro" node in
the Formula Helper window

3203 If folders exist on a parent folder, and these folders contain no
custom macros, Campaign still displays the folder.

Selected derived field under
Based on drop-down of
advanced setting window
should open in Edit mode

9055 When clicking the button to see the details of a derived field
added on the MORE section, the derived field should open in
edit mode. Instead a Create Derived Field window opens.
Users can select the derived field from the drop-down.

Dialog boxes cannot be
resized

11162 You cannot maximize or resize dialog boxes in Campaign (for
example Process Configuration or Table Mapping dialogs).

Error 19024: Cannot delete
segment folder if the segment
was deleted from the folder.

17202 A segment that is deleted from a folder remains as an inactive
segment in the folder. Folders with inactive segments cannot
be deleted. This is working as intended.

If the same flowchart is edited
in multiple locales, undesired
behavior can occur.

18991 This situation occurs only if two (or more) users with different
language settings edit the same flowchart. Users with different
locales should not edit the same flowchart that was created by
a user with a different locale since this can lead to undesired
behavior. The preferred approach is to create and edit
flowcharts with users having the same language settings.
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Table 3. Campaign known limitations (continued)

Issue ID Description

SPSS Model cannot be built in
SPSS MA from stream
generated from SPSS Model
process in Campaign (via
Create new modeling stream).

50742 Before the SPSS Model process box has been run, the data
source defined in the SPSS modeling stream is based on a
dummy file of only 4 records and cannot be used for
modeling interactively (from the Model tab in the SPSS GUI).
The user can change the data source and model manually, or
they can run the Model process which will pull the real data
and populate the configured data source and then
subsequently manually initiate modeling in the modeling
stream.

Copy and Paste behavior in
TCS

64710 You cannot copy data into the target cell spreadsheet (TCS)
using Copy and Paste. For example, you cannot copy rows
from an Excel spreadsheet and paste them into a TCS. This is
a browser limitation for security reasons. Instead, use Import
Target Cells to import data from a comma-separated values
(.csv) file.

To copy data out of the TCS, use Export Target Cells.

Linked cell is not highlighted
after linking a cell and
re-opening "Link to target cell"
in a Segment or Sample
process.

65815 A linked cell in a Segment or Sample process configuration
dialog box is not highlighted in the Output Cell Name list (on
the General tab). It should be highlighted to to indicate that it
is linked to a cell in the target cell spreadsheet (TCS).

Copy and paste behavior in
process boxes and other
dialogs

84147 For security reasons, some browsers do not allow applications
to copy and paste via the Clipboard. This affects the General
tab of the Segment process configuration and other areas of
the application where copy and paste might be used.

Campaign utilities 161323 The error "Login failed. Error 10553" can occur if you try to
log in to the Campaign utilities when the IBM Marketing
Platform | Security | login method is set to Windows
integrated login or Web access control. To avoid this issue,
change the login type to LDAP or IBM Marketing Platform
prior to using the Campaign utilities.

Process box connection arrow
changes direction

201968, 200241 If two process boxes are moved very close together in a
flowchart, the direction of the connection arrow changes. This
limitation affects the visual representation of the arrow. The
process data flow is not affected. The workaround is to move
the process boxes farther apart so the arrowhead changes back
to the correct direction.
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Chapter 6. IBM Campaign Reports Package

The Campaign Reports Package delivers reporting schemas that you can use to
track campaign, offer, and cell performance. To use the Reports Package, Campaign
must be integrated with IBM Cognos®

For more information, see the IBM EMM Reports Installation and Configuration Guide
that is supplied with IBM Marketing Platform.

The IBM Campaign Reports Package contains the following items:
v Schemas that are registered with IBM Marketing Platform during installation.

They describe the attributes and metrics that represent the product's reporting
schema and include:
– Base schemas that are the basis of the reporting schema (with no custom

attributes)
– Custom versions of most of the base schemas that rely on the preconfigured

custom attributes for Campaign
– Templates that you can use to create new schemas

v IBM Cognos customizable model and reports to be deployed on an IBM Cognos
BI Server

v Reference documentation that describes the IBM Cognos model and the reports.
Documentation can be found in the directory ReportsPackCampaign\cognos10\
CampaignDocs.

The Campaign reports retrieve data from one data source: the Campaign system
tables.

Reporting Schemas

The following reporting schemas are provided:
v Campaign Views provides the standard attribute views of the Campaign system

tables (campaign, offer, cell, and so on).
v Campaign Custom Attributes is for reporting on custom attributes of campaigns,

offers, and cells.
v Campaign Performance is used by reports that display performance

measurements starting at the campaign level over all time or various periods of
time (days, months, and so on).

v Offer Performance is used by reports that display performance measurements
starting at the offer level over all time or various periods of time (days, months,
and so on).

v Campaign Offer Response Breakout is used by reports that show campaign and
offer responses based on response types.

v Campaign Offer Contact Status Breakout is used for measurement of campaign
and offer contacts based on contact status.

The custom schemas extend the last five of the listed schemas to include the
default, preconfigured response types, custom attributes, and so on.
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Templates

If you have additional audience levels, you can create additional reporting schemas
for them with the following templates:
v Campaign Views
v Campaign Custom Attributes
v Campaign Performance
v Offer Performance
v Campaign Offer Response Breakout
v Campaign Offer Contact Status Breakout

Reports

The reports package contains Cognos example reports that can be accessed from
the Analytics menu or the Analysis tab for a campaign or offer. Reports can also be
displayed in portlets on the Dashboard.

The following campaign-specific example reports are available from the Campaign
Analysis tab:
v Campaign Detailed Offer Response Breakout
v Campaign Financial Summary by Offer (Actual)
v Campaign Offer Performance by Month
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell with Revenue
v Campaign Performance Summary by Offer
v Campaign Performance Summary by Cell and Offer
v Campaign Performance Summary by Cell and Offer (with Revenue)

The following offer example reports are available from the Offer Analysis tab:
v "What If" Offer Financial Summary
v Offer Performance by Day
v Offer Performance Summary by Campaign

The following cross-object example reports include information about multiple
objects in Campaign. These reports are available from the Campaign Analytics
page.
v "What If" Offer Financial Summary
v Campaign Detailed Offer Response Breakout
v Campaign Financial Summary by Offer (Actual)
v Campaign Offer Performance by Month
v Campaign Performance Comparison
v Campaign Performance Comparison (with Revenue)
v Campaign Performance Comparison by Initiative
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell (with Revenue)
v Campaign Performance Summary by Cell by Initiative
v Campaign Performance Summary by Offer
v Campaign Performance Summary by Offer (with Revenue)
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v Campaign Performance Summary by Cell and Offer
v Campaign Performance Summary by Cell and Offer (with Revenue)
v Campaign Summary
v Offer Campaign Listings
v Offer Performance by Day
v Offer Performance Comparison
v Offer Performance Metrics
v Offer Performance Summary by Campaign

The following campaign-specific example report portlets are available on
dashboard pages:
v Campaign Response Rate Comparison
v Campaign Return on Investment Comparison
v Campaign Revenue Comparison by Offer
v Offer Response Breakout
v Offer Response Rate Comparison
v Offer Responses for Last 7 Days
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Chapter 7. IBM Campaign documentation roadmap

IBM Campaign provides documentation and help for users, administrators, and
developers.

Table 4. Get up and running

Task Documentation

View a list of new features, known issues, and
limitations

IBM Campaign Release Notes

Learn about the structure of the Campaign database IBM Campaign System Tables and Data Dictionary

Install or upgrade Campaign and deploy the Campaign
web application

One of the following guides:

v IBM Campaign Installation Guide

v IBM Campaign Upgrade Guide

Implement eMessage, if you purchased eMessage v The IBM Campaign Installation and Upgrade guides
explain how to install and prepare eMessage
components in the local environment.

v The IBM eMessage Startup and Administrator's Guide
explains how to connect to the hosted messaging
resources.

Implement the IBM Cognos reports provided with
Campaign

IBM EMM Reports Installation and Configuration Guide

Table 5. Configure and use Campaign

Task Documentation

v Adjust configuration and security settings

v Prepare Campaign for users

v Run utilities and perform maintenance

v Integrate Campaign with Digital Analytics

IBM Campaign Administrator's Guide

v Create and deploy marketing campaigns

v Analyze campaign results

IBM Campaign User's Guide

Improve flowchart performance
IBM Campaign Tuning Guide

Use Campaign macros IBM Macros for IBM EMM User's Guide

Table 6. Integrate Campaign with other products

Task Documentation

Configure eMessage offer integration. IBM Campaign Administrator's Guide

Integrate and use Campaign with Digital Analytics IBM Campaign Administrator's Guide

Integrate and use Campaign with IBM SPSS Modeler
Advantage Marketing Edition

IBM Campaign and IBM SPSS Modeler Advantage Marketing
Edition Integration Guide

Integrate and use Campaign with Marketing Operations IBM Marketing Operations and IBM Campaign Integration
Guide
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Table 7. Develop for Campaign

Task Documentation

Develop custom procedures with the API v IBM Campaign Offer API Specification

v JavaDocs in devkits\CampaignServicesAPI

Develop Java™ plug-ins or command-line executables to
add validation to Campaign

v IBM Campaign Validation PDK Guide

v JavaDocs in devkits\validation

Table 8. Get help

Task Instructions

Open online help 1. Choose Help > Help for this page to open a
context-sensitive help topic.

2. Click the Show Navigation icon in the help window
to display the full help.

Obtain PDFs Use either of the following methods:

v Choose Help > Product Documentation to access
Campaign PDFs.

v Choose Help > All IBM EMM Suite Documentation
to access all available documentation.

v Access all documentation during the installation
process from the IBM EMM installer.

Get support Go to http://www.ibm.com/ and click Support &
downloads to access the IBM Support Portal.
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Before you contact IBM technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company's designated support contact can log a call with
IBM technical support. Use these guidelines to ensure that your problem is
resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
administrator for information.

Note: Technical Support does not write or create API scripts. For assistance in
implementing our API offerings, contact IBM Professional Services.

Information to gather

Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages that you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM technical support, you might be asked to provide information
about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, check for a version.txt file that is located under the installation
directory for your application.

Contact information for IBM technical support

For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.ibm.com/support/entry/portal/open_service_request).

Note: To enter a support request, you must log in with an IBM account. This
account must be linked to your IBM customer number. To learn more about
associating your account with your IBM customer number, see Support Resources
> Entitled Software Support on the Support Portal.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information about the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations
IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."
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